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AbOUt \/a|ora = AutoClassification platform for Information Governance

= Automates discovery, identification, classification &
defensible disposition

= Trusted by IG teams, Records & IM teams, Legal,

g X Compliance, IT teams
o 0 - o _ = Brings multiple enterprise repositories into a single view
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Poll Results

Who's here today
& what are your interests?
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Who you are & what your challenges are

Records / Information Management I
O\ Knowledge Management
e @
dh 4 Legal
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Compliance [N
Who You Are

IT

Data Privacy / Security

Other



Who you are & what your challenges are

File clean-up / ROT reduction
Stranded/unknown content in legacy...

Dark data: we don't know what we have or...
)
o © o

- - utomating our manual processes

Data Privacy Compliance / Identifying...

Your R | I\/l & Managing content on Legal Hold
Managing retention policies
|G Challenges

Migration to a new system

Al readiness

OMG everything



Housekeeping

| I | I | Recording

Feedback




Types of Al

Transparent & defensible 2

Machine Learning
Algorithms that enable computers
to learn from and make predictions

or decisions based on data.

Generative Al

Creates new content on the
data it has been trained on.

Extractive Al

Extracts specific information
from large datasets or text.

@

Agentic Al
Operates independently, making
decisions & performing tasks
without human intervention.



10 Practical Ways AutoClassification Impacts Al




Prevents Al from Accessing Sensitive Data

Why it Matters
Al cannot distinguish sensitive content from non-sensitive content unless the organization can.

Identifies PII, PHI, legal, financial & other

confidential content LLM deployment excludes documents labelled:
Allows organization to: « “Attorney-Client Privileged”

» Restrict what Al tools can access + “Confidential HR"

» Apply policy-based guardrails » "Patient Data”

» Prevent accidental data leakage

Result : Al becomes usable without exposing risk



Improves Retrieval Accuracy for RAG & Enterprise Search

Why it Matters
Retrieval-Augmented Generation (RAG) is only effective if the right content is retrieved.

, Giving Al the "right data” to source answers from,
What is RAG? not just what it was trained on.
+. ' .+ - Retrieve, then generate
\‘\ | '/0 « Grounding responses in data
* ! / - Source attribution

Common use cases
« Summarize this document
- What does our policy/manual/SOP say about xyz?
- Find me everything related to xyz

RAG = Open Book Exam - Helpdesk bots



2 Improves Retrieval Accuracy for RAG & Enterprise Search

Why it Matters
Retrieval-Augmented Generation (RAG) is only effective if the right content is retrieved.

How AutoClassification Helps

) _ Example
Enriches docs with metadata: Improves: . » ”
. Instead of retrieving every “contract”,
* Document Type » Search precision : .
. . . Al retrieves:
» Topic » Semantic ranking .
 Active vendor contracts
* Record Type » Context relevance : .
. _ » Based in North America
* Business process * Response quality

. » Executed in the last 24 months
« Jurisdiction

Result : More accurate Al answers with less hallucinations.



%4 Reduces Al Hallucinations

Why it Matters
LLMs hallucinate when they retrieve low-quality, outdated, or irrelevant content.

What is an Al

hallucination? Where an Al (LLM) generates confident, realistic, and
coherent content that is factually incorrect, , or
ungrounded.

It is not a "bug" but a result of Al predicting plausible
patterns rather than verifying facts.




%4 Reduces Al Hallucinations

Why it Matters
LLMs hallucinate when they retrieve low-quality, outdated, or irrelevant content.

' Convincing misinformation: looks perfectly credible,
What is an Al makes it hard to distinguish from correct information
hallucination? (fake citations, fabricated legal cases, non-existent events)

Root Cause: LLMs are trained to predict the most
statistically likely next word is a sequence, not to maintain
a factual database of realty.

Trigger Factors: often occur when the necessary
information is missing, ambiguous or outside the training
data.




Reduces Al Hallucinations

Why it Matters
LLMs hallucinate when they retrieve low-quality, outdated, or irrelevant content.

How AutoClassification Helps
AutoClassification helps Al prioritize:
« Authoritative content

Final versions (vs drafts)

Approved policies

Current procedures

Trusted repositories

Example

Al references:

 Final policy document instead of
Old drafts in shared drives

Result : Higher confidence & trust in Al outputs.



Enable Policy-Based Al Governance at Scale

Why it Matters
Manual governance does not scale across millions of files.

How AutoClassification Helps

AutoClassification operationalizes Example

governance automatically: Documents classified as:

» Retention » “EU Personal Data”

» Privacy enforcement automatically become:

* Legal hold » Restricted from non-EU Al processing

» Geographic & regulatory restrictions

Result : Governance becomes enforceable instead of aspirational.



5] Reduces Bias in Al Training Data

Why it Matters
Poorly governed data introduces bias into Al models.

. . . Refers to systematic, unfair outcomes produced by Al
’? )
What is bias in Al’ systems that privilege certain groups over others, often
reinforcing existing human prejudices or societal
inequalities.

It occurs when Al models are trained on flawed,
unrepresentative data or designed with skewed
assumptions, leading to skewed predictions in areas like
hiring and lending.




5] Reduces Bias in Al Training Data

Why it Matters
Poorly governed data introduces bias into Al models.

. _ Data Bias (unrepresentative data): Al trend on data that
What causes bias in Al?  does not accurately reflect the target population.

Historical or societal bias: models learning from historical
data that contain human prejudice.

Measurement bias: when data collection methods in
accurately measure “something” leading to distorted, non-
neutral data sets interaction.




5] Reduces Bias in Al Training Data

Why it Matters
Poorly governed data introduces bias into Al models.

Hiring algorithms (gender bias): Preferencing male candidates
What are some examples ~ over female candidates for technical roles based on skewed

of bias in Al? historical hiring data.

Healthcare algorithms (socioeconomic/racial bias): an
algorithm used to manage patient care for a major health
system prematurely recommended ending coverage for
elderly patients based on flawed metrics.

Image generation (stereotyping): reproducing gender and racial
stereotypes in image generation (ex. associating ‘nurse” with
women, or “entrepreneur” with white men)



D

Reduces Bias in Al Training Data

Why it Matters
Poorly governed data introduces bias into Al models.

What are th? cqnsequences Discrimination: Perpetuating & amplifying discrimination
of bias in Al? against marginalized groups.

Reputational/Legal Risk: Organizations may face lawsuits
and loss of trust if their Al systems exhibit disparate
impacts on protected classes.

Amplification: Unchecked Al can create a feedback loop
that makes humans more biased themselves.




5] | Reduces Bias in Al Training Data

Why it Matters
Poorly governed data introduces bias into Al models.

How AutoClassification Helps
AutoClassification can identify:
» Redundant data

» Skewed datasets

Outcomes:
» Curates balanced training sets
» Supports fairness & responsible Al

. . : Initiatives
 Sensitive demographic information o
. . » Reduces exposure to discriminatory
* Inappropriate training content
outcomes

(old/now inappropriate data, terms)

Result : Cleaner datasets & reduced algorithmic bias.



Makes Al Outputs More Defensible

Why it Matters
Organizations increasingly need to explain why Al produced an answer,
what data it used, & whether it complied with policy.

AutoClassification provides:

» Traceability » Enables explainability and auditability

* Data provenance « Connects Al outputs to authoritative
» Contextual metadata sources

 Auditability

Result : Greater legal defensibility & audit readiness.
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Reduces Al Costs by Eliminating ROT

Why it Matters
Al processing massive amounts of redundant data is expensive.

V\/hy is Al processing “Tokens” are the currency Al runs on.
ROT A0 Every interaction consumes a token: ex. input / output
SO EXpeEnsive: - 1 token = 4 characters

Model / Platform Context Window (Tokens Rough Equivalent
= ( ) = gh Eq =

OpenAl (ChatGPT - GPT-40 /

128,000 tokens ~300 pages
4.1 class)
Anthropic Claude 3

200,000 tok ~500
(Opus/Sonnet/Haiku) 0,000 tokens S00pages
Google Gemini (1.5 Pro) Up to ~1IM tokens ~2,500+ pages
Google Gemini (1.5 Flash) ~1M tokens (optimized) ~2,500+ pages
OpenAl (older GPT-4 Turbo) 128,000 tokens ~300 pages




WAl Reduces Al Costs by Eliminating ROT

Why it Matters
Al processing massive amounts of redundant data is expensive.

Why is Al processing Hidden Multipliers (ROT):

: - Same data, stored differently
ROT so eXpenSIVe? - Duplication (Redundancy)

- Repeated efforts
- Re-indexing

Messy data = more complexity = more tokens
= more cost & worse results

- IfROT is 50%, Al costs are 50% + inflated



WAl Reduces Al Costs by Eliminating ROT

Why it Matters
Al processing massive amounts of redundant data is expensive.

How AutoClassification Helps
AutoClassification identifies:
* Redundant

* Obsolete

 Trivial data

Outcomes:

* Archive or delete unnecessary
content (gasp!)

* At a minimum, not feed it to your Al

Result : Lower Al infrastructure costs & faster (correct) retrieval.



Enables Context-Aware Al Experiences

Why it Matters
Al becomes more useful when it understands business context.

How AutoClassification Helps Outcomes:

AutoClassification enriches content » Adds business meaning to enterprise
with business meaning, identifies: content

* Project » Improves personalization &

« Customer — Active / Inactive recommendations

» Product » Enhances Al understanding of

« Jurisdiction / Region / Office business workflows

» Process / Lifecycle stage

Result : Smarter recommendations & more personalized Al responses.



Accelerates Al Readiness & Deployment

Why it Matters
Most Al projects stall because organizations don't trust their data estate.

AutoClassification helps organizations:

* Inventory content « Supports remediation before Al

* Understand, then mitigate risk rollout

« |dentify sensitive data » Confidence in the data its training on
« |dentify corporate data appropriate for » Accelerates secure Al adoption

training Al model

Result : Faster Al roll-out with fewer security concerns & objections.



0] Builds Trust in Enterprise Al

Why it Matters
Al adoption ultimately depends on trust.

Employees are more likely to use Al
when they know:

« (their) sensitive content is protected

» Governance is enforced

» Results come from trusted sources

« Compliance obligations are respected

Employees confidently use internal Al
because:

* HR records are excluded

» |Legal data is protected

» Responses cite approved sources

Result : Higher adoption & better business outcomes.



Il Enables Al Recovery & Rebuild Readiness

Why it Matters
You have a way back if you need to retrain, rebuild, or replace Al systems after model collapse.

What is an

Al model Co||apse? Model collapse refers to the degradation of Al quality
over time when models increasingly train on:
- synthetic Al-generated content
- low-quality data
- duplicated information
- biased outputs
- hallucinated content



Il Enables Al Recovery & Rebuild Readiness

Why it Matters
You have a way back if you need to retrain, rebuild, or replace Al systems after model collapse.

AutoClassification preserves: AutoClassification becomes
» Sensitivity labels “institutional memory”:

» Business context » GenAl vendors will change
* Record types « Models will falil

» Retention categories  Architectures will evolve

Regulatory context
Identifies Al-generated content

Result : When Al systems fail, governed data becomes the recovery foundation.



Key Takeaways

Al is only as good as the data it can access

AutoClassification is becoming foundational
to Al governance

Classification improves trust, security,
accuracy, and defensibility

Organizations with governed data deploy Al
faster, safer, and cheaper
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